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Warranty 2
Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of shipment. If
any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective product without charge for parts
and labor, or will provide a replacement in exchange for the defective product. Parts, modules and replacement products used by Tektronix for
warranty work may be new or reconditioned to like new performance. All replaced parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period and make
suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the defective product to the service
center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a
location within the country in which the Tektronix service center is located. Customer shall be responsible for paying all shipping charges, duties,
taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care. Tektronix
shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel other than Tektronix
representatives to install, repair or service the product; b) to repair damage resulting from improper use or connection to incompatible equipment; c) to
repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or integrated with
other products when the effect of such modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY
PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other component
manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country of use.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the
product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category II, III, or IV circuits.

Power Disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it must remain
accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Replace Batteries Properly. Replace batteries only with the specified type and rating.
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General Safety Summary

Recharge Batteries Properly. Recharge batteries for the recommended charge cycle only.

Use Proper AC Adapter. Use only the AC adapter specified for this product.

Do Not Operate in an Explosive Atmosphere.

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.
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General Safety Summary

The following symbols may appear on the product:
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Environmental Considerations

Environmental Considerations
Product End-of-Life Handling
Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life. In
order to avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

The symbol shown below indicates that this product complies with the European Union’s requirements according to Directive
2002/96/EC on waste electrical and electronic equipment (WEEE). For information about recycling options, check the
Support/Service section of the Tektronix Web site (www.tektronix.com).

Restriction of Hazardous Substances
This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS Directive.
This product is known to contain lead, cadmium, mercury, and hexavalent chromium.
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Preface

Preface
This manual describes the installation and basic operation of the RF Scout Interference Hunter. For more detailed information, see
the online help on your instrument.

Key Features
The RF Scout is a rugged, multi-standard spectrum analyzer and interference mapping tool optimized for field use. Key features
include:

Interference hunting functions that help find interference quickly

Spectrogram display for detection and logging of intermittent signals

Signal strength, AM/FM demodulation, and noise floor measurements

Scanners for GSM/GMSK/EDGE, UMTS/W-CDMA/HSDPA, cdmaOne/cdma2000, and cdma2000 1xEV-DO signals

iMap Integrated Mapping for in-field analysis of interference and coverage problems
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Preface

Documentation
To read about Use these documents
Installation and operation (overviews) RF Scout Interference Hunter Quick Start User Manual. The quick start user manual

contains general information about how to put your instrument into service, guides to
user interface controls, and application examples.

Help using the application RF Scout Interference Hunter Online Help. The online help is context sensitive,
displaying information appropriate for the active screen.

Software Upgrades
Periodic software upgrades may become available. The software is only operational if you have a valid option key for the specific
application module and serial number.

To check for upgrades:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Select Software & Drivers to link to the Software and Firmware Finder Web page.

3. Select Network Management & Diagnostics in the Browse by product category list.

4. Select Wireless Field Test Products in the Browse by product series list.

5. Select GO to display a list of software downloads.
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Preface

Conventions Used in This Manual
This manual describes how to operate the RF Scout Interference Hunter application. Although the methods of operation are identical
for all measurement options, differences in configuration or application are identified in the text by the option to which they apply.

The following icons are used in this manual:

Sequence
Step

Front panel
power

Connect
power
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Preface

Preventing Personal Injury from Lightning

WARNING. To prevent personal injury from the effects of lightning, exercise the following precautions when using this product:

Before connecting this product to any source
Check your local weather forecast for the possibility of thunderstorms or lightning.

If weather conditions could allow thunderstorms or lightning to develop, be sure to visually check the sky and weather
conditions in your area frequently.

If you can hear thunder or if you see lightning, do not connect this product to any source which may be exposed to the
effects of lightning.

Use your own good judgement and common sense. You must protect yourself from the effects of lightning.

You must assume that hazardous voltages will be present on exposed surfaces of this product if it is connected to a source
exposed to lightning. The insulation of this product will not protect you from these hazardous voltages.
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Preface

Do not connect this product to any source which might be subject to the effects of lightning
If thunderstorms or lightning are in your vicinity:

When weather conditions that could lead to lightning activity exist in your area, you could be at risk of a lightning strike
before the cloud is close enough for you to hear thunder or see lightning.

When lightning strikes a structure or facility, current travels through rebar, concrete, pipes, cables, vent stacks, and electrical
system.

Lightning can induce electric and magnetic fields into structures and portions of wiring. The length of a conductor affected by
the magnetic field of a lightning strike may exceed two miles.

Be alert and aware of the effects of lightning
When lightning strikes a conductor, which in turn introduces the current into an area some distance from the ground strike point,
equipment can be damaged and personnel injured if they become an indirect path in the completion of the ground circuit.

Conductors such as the braided shields of cables or unshielded wires will have significant transient currents flowing in them
in regions exposed to the electric field effect of lightning.

Induced voltages may cause breakdown of insulation in wiring at connectors and in electrical components or breakdown of air.
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Installation

Installation
Carefully unpack your instrument and verify that it includes the standard accessories.

Standard Accessories
Accessory Part Number
NetTek Y400 Analyzer Platform Y400
NetTek YBT250 Field Transmitter & Interference Tester YBT250
AC Power Adapter 119-6984-xx
Lithium-Ion Battery 146-0151-xx
NetTek Y400 Analyzer Setup Reference 071-1430-xx
RF Scout Interference Hunter Quick Start User Manual 071-1901-xx
NetTek YBT250 Field Transmitter & Interference Tester installation CD 063-3476-xx

Your instrument may also include optional accessories. Verify that the optional accessories you ordered are included with your
instrument. For a current list of accessories, upgrades, and options, including service options, available for your RF Scout,
visit the Tektronix Web site, www.tektronix.com.
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Installation

Operating Considerations
RF Scout Interference Hunter

AC Adapter Input voltage and current: 100 V - 240 V AC, 1.8 A
Input frequency: 47 Hz to 63 Hz
Output voltage and current: 24 V DC, 3 A

Dimensions Height: 25 cm. (9.75 in)
Width: 33 cm. (13 in)
Depth: 9 cm. (3.5 in)

Weight 5.52 kg (12.125 lbs) (with one battery)
Temperature Range Operating: 0 °C to +50 °C specified performance, -10 °C to +50 °C typical

Nonoperating: -40 °C to +60 °C
Humidity Operating: 5% to 95% Relative Humidity (RH), noncondensing: up to +30 °C

Nonoperating: 5% to 45% Relative Humidity (RH), noncondensing: +30 °C up to +50 °C
Altitude Operating: Up to 4,600 m (15,092 ft.)

Nonoperating: Up to 15,240 m (50,000 ft.)
NetTek YBT250
Module, RF INPUT

Input frequency range: 30 MHz to 2500 MHz
Coupling: AC
Input impedance: 50 Ω (nominal)
Maximum Input Power without Damaging Instrument: 50 W CW or peak envelope power
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Installation

Cleaning
Clean the exterior surfaces of the instrument with a dry lint-free cloth or a soft-bristle brush.

Use a cloth or swab moistened with deionized or distilled water, or a 75% isopropyl alcohol solution for more stubborn stains, to
clean the instrument or touch screen; use just enough moisture to dampen the cloth or swab.

Use a gentle amount of force when cleaning the touch screen.

CAUTION. Do not get moisture inside the instrument during exterior cleaning.

Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument.

Do not spray liquids directly on the instrument or touch screen.

Do not use abrasive cleaners, or chemical cleaning agents that contain benzene, toluene, xylene, acetone, or similar solvents; they
can damage the instrument or touch screen. Do not use commercial glass cleaners to clean the touch screen.

Do not scrub the touch screen with excessive force while cleaning.
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Installation

Connecting the AC Adapter
1. Lift the instrument strap to expose the

power adapter connector.

2. Connect the AC power adapter to the
instrument.

3. Connect the AC adapter to a
properly-grounded AC power source
using the provided power cord.

4. Charge the batteries before using the
instrument on battery power for the first
time.(See page 5, Charging the Batteries.)
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Installation

Charging the Batteries
Charge the batteries before using the instrument on battery power for the first time. Batteries are partially charged and calibrated
at the factory. A calibrated battery allows the instrument to more accurately estimate how long the application modules can
operate before the instrument automatically powers off. The front-panel BATTERIES charge status indicator turns off when
charging is complete.

Approximate charge time

Number of batteries Instrument powered on Instrument powered off
1 8 hours 3 hours
2 16 hours 6 hours

NOTE. These are typical numbers for batteries that are low but not completely discharged. Newer-model instruments can contain
higher-capacity batteries, resulting in increased run time and longer charge time.

For more information on battery charging, battery calibration, and instrument power management, access the instrument online help:
Start > Help > Tektronix Basics > Power Management.
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Powering On and Off the Instrument
1. Tap the On/Standby button to power on

the instrument.
The instrument WindowsCE Status bar
shows the Battery icon when running off of
batteries, or the External Power connected
icon when powering the instrument with an
external adapter.
To power off the instrument, tap the
On/Standby button again.

For information on the instrument on/standby
power modes, access the RF Scout online help:
Start > Help > Tektronix Basics > Shutting
Down the Instrument.
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Functional Verification
Perform this functional check to verify that your instrument is operating properly

1. Power on the instrument.

2. Watch the screen. Verify that the
instrument does not display any power-on
diagnostic error messages.
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Touch Screen Concepts
The RF Scout user interface is based on touch-screen technology. Instead of using physical button and knob controls to select
functions, set values, and take measurements, you tap (touch) virtual controls on the instrument screen. Virtual controls behave
the same way as physical controls.

The following are touch screen terms used in this manual:

Term Description Equivalent mouse operation
Stylus The physical object you use to touch the screen. A stylus is either

your finger or an appropriate plastic-tipped stylus. Do not use any
metal-tipped objects or pens for a stylus, as they can damage
the touch screen.

The mouse pointer.

Tap Touch the screen briefly with the stylus. Selects the item on the
screen.

The left mouse button.

Drag Press gently on the screen with the stylus, drag the stylus to a
new position, and then raise the stylus from the screen. Moves an
item or selects an area.

Drag (hold down the left mouse
button, move the mouse, and then
release the button).
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Calibrate the Touch Screen
Calibrate the touch screen display to respond correctly to your taps.

1. Tap Start > Settings > Control Panel to
open the Control Panel Screen.

2. Double-tap the Stylus icon on the Control
Panel screen.

3. In the Double-Tap tab, double-tap the
checkerboard grid at a comfortable speed
with your stylus or finger to set the tap rate.

4. Double-tap the test icon to verify your
settings.
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5. Tap the Calibration tab and read the
instructions.

6. Tap the Recalibrate button to open the
Cursor Position target screen.

7. Follow the target screen instructions.
When the position target disappears, touch
anywhere on the screen to return to the
Calibration tab.

8. Tap OK to save calibration settings.
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Starting the RF Scout Application
If purchased preloaded, RF Scout starts automatically when you power on the instrument. If RF Scout does not start automatically,
or you have stopped the application, use either of the following methods to start the application:

Double-tap the RF Scout icon on the
instrument screen

Select Start > Programs > NetTek >
RF Scout
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Either method opens the RF Scout application

NOTE. You cannot run RF Scout at the same time as the YBT250 applications. However, you can run RF Scout and the YBA250
application module as long as you are not measuring Insertion Gain/Loss.

The Microsoft WindowsCE taskbar displays a button for each running application. To bring the RF Scout to the front of the
screen, tap the RF Scout button in the taskbar.
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Setting Display Colors
You can change the color scheme used in the instrument display. The color schemes optimize the display colors for use in different
environments (outdoors versus indoors) and for better printing quality on black and white (monochrome) printers.

1. Select Tools > Options.

2. Tap the Preferences tab.

3. Tap the Color Scheme list field and select
a display color scheme.

4. Tap OK.

5. Select File > Exit to close RF Scout. Then
restart the RF Scout application to enable
the changed color scheme.
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Enabling Signal Standards
Before you begin using the RF Scout, you must enable (select) the signal standards that you want to measure. You can only take
measurements on enabled standards.

1. Select Tools > Options.

2. Tap the Signal Standards tab.

3. Tap the name of the standard in the Signal
Standards supported list that you want
to enable. Drag the stylus to select two or
more contiguous standards.
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4. Tap the Add >> button to add the selected
standard(s) to the Signal Standards
selected list.

5. Tap OK. The enabled standards are now
selectable from the main window Signal
Standards drop-down list.

NOTE. Limiting the number of standards enabled to just those that you regularly test makes it easier and faster to select a
standard from the Signal Standard drop-down list.
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Getting Acquainted with Your Instrument
RF Scout Elements

1. NetTek Y400 Analyzer Platform.

2. Battery compartment.

3. NetTek YBT250 Application Module.

4. Input/Output ports. (See page 19,
Input/Output Connectors (NetTek Y400).)

5. PCMCIA card ports.

6. Power and Status panel. (See page 18,
Power On/Standby and Status Panel.)

7. External adapter power connector. (See
page 4, Connecting the AC Adapter.)

8. Touch screen.
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Power On/Standby and Status Panel
1. Power On/Standby button. Push to

power on or off the instrument. For more
information, access the online help: Start
> Help > Tektronix Basics > Shutting
Down the Instrument.

2. Recessed instrument reset button.
Performs a hardware reset; all programs
and data loaded into volatile memory since
power-on are lost. Generally only used to
recover from a system lock-up. Use a thin
probe or similar item to push the recessed
switch.

3. Power/Display status. Green indicates
that the instrument is powered on. Amber
indicates that the instrument is powered
on but the display is turned off (for power
conservation).

4. Battery status. Green indicates that the
instrument is connected to an external
power source and is charging installed
batteries. Red indicates a low battery.
No color indicates that the batteries are
charged.
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Input/Output Connectors (NetTek Y400)
1. Microphone input

2. Headphone jack

3. Ethernet connector (RJ-45)

4. Serial RS-232 connector

5. PS/2 keyboard connector

6. USB Host connector

7. USB Slave connector
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NetTek YBT250 Module Signal Connectors
1. Timing Input. Connects to an external

timing reference signal, such as a BTS
Even Second Clock signal, or the timing
signal from a Tektronix YBGPS1 GPS
Timing Reference.

2. Frequency Reference Input. Use an
external frequency reference signal to
improve measurement accuracy.

3. RF Input. The RF Input connects the
RF input signal source or measurement
antenna to the instrument.
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Microsoft WindowsCE Elements
The Microsoft WindowsCE user interface is similar to other Microsoft Windows operating systems. You use standard Microsoft
Windows operations to start (run) applications, select and move objects, and open folders or files. For more Microsoft WindowsCE
information, access the online help: Start > Help > WindowsCE Basics.

The Status area, located at the bottom right of the screen, contains icons that display important information about the instrument
power status. For an explanation of all status area icons, access the online help: Start > Help > WindowsCE Basics >
Understanding Taskbar Icons.
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The RF Scout User Interface
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1. Command bar. Contains the application menus, as well as buttons for saving measurement results, opening the application
setup dialog box, and running/pausing the application. (See page 24, The Command Bar.)

2. Tuning controls. Selects the signal standard, signal direction (uplink or downlink), measurement channel, and measurement
frequency. (See page 25, The Tuning Controls.)

3. Measurement Results. Shows the waveform displays, measurement results, and mapping screen. The appearance of this
area changes depending on the selected measurement mode and measurement type.

4. GPS, External Reference and RF Signal Gain/Loss status buttons. Indicates status and sets GPS, measurement reference
frequency source, and input signal attenuation or amplification parameters. (See page 26, The External Signal Status Buttons.)

5. Measurement Mode buttons. Selects the Spectrum (button 1), Channel (button 2), or Mapping (button 3) measurement
modes. (See page 28, The Measurement Mode Buttons.)

6. Parameter Entry controls. Provides controls for entering or changing numeric values of the selected user interface field or
item. (See page 29, The Parameter Entry Controls.)
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The Command Bar

Element Description
Menus. See the RF Scout Online help topic Menus for information on the RF Scout menu functions.

Save Results button. Saves the current measurement acquisition to a file. See the RF Scout Online
help topic The Save & Export Tab for how to set file save parameters.

Log Measurements button. Enables automatically taking and saving a measurement at specified
time intervals. See the RF Scout Online help topic The Logging Dialog Box for how to set the time
interval between measurement acquisitions.
Edit button. Opens the Setup dialog box that contains instrument settings tabs. See the RF Scout
Online help topic Setup Tabs for information on the setup dialog tabs.
Open button. Shows the Open dialog box that lists saved instrument setup files to load and
configure instrument settings. See the RF Scout Online help topic The Setup Menu Tab for
directions on how to switch the button between the Edit and Open modes.
Run/Pause button. Runs or Pauses the current measurement acquisition.

Help button. Opens the online help. Help is context-sensitive and will display a help topic related
to the current RF Scout measurement mode.
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The Tuning Controls

Element Description
The Signal Standard drop-down list displays the enabled signal standards from which you
select a standard to measure. (See page 14, Enabling Signal Standards.)

The Downlink and Uplink buttons change the Freq (MHz) setting to the forward link (downlink)
or reverse link (uplink) frequency of the current signal standard and channel. For W-CDMA
signals, these buttons set the corresponding forward or reverse channel number.
The Channel button sets the channel number. The field next to the button shows the current
channel number. Tapping the button opens the numeric keypad, with which you enter
a channel number.
The current signal standard defines the available channel numbers. Setting the channel
number sets the instrument measurement frequency to the appropriate value for the selected
signal standard and up or downlink mode setting.
The Freq (MHz) button sets the Measurement Frequency. The field next to the button
shows the frequency. Tapping the button opens the numeric keypad, with which you enter
a frequency value.
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The External Signal Status Buttons

Element Description
The GPS status button indicates the GPS signal lock status of an attached GPS receiver. A green dot indicates
that the GPS receiver is active (locked to four or more satellites and able to calculate accurate position data). Tap
this button to open the GPS setup tab. See the RF Scout Online topic The GPS Tab for more information on
setting GPS parameters.
The Measurement Reference Frequency status button indicates the measurement frequency reference source. Tap
this button to open the Inputs tab. Use this button if you connect an external measurement reference frequency
source to the RF Scout.
The available measurement reference frequency sources are the internal instrument frequency reference (F INT),
an external reference (F EXT), or a GPS-derived timing reference from the Tektronix YBGPS1 GPS Timing
Reference (F GPS).
See the RF Scout Online topic The Inputs Tab for more information on setting the measurement reference
frequency source.
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Element Description
The RF Input Signal Gain/Loss status button shows the external attenuator or amplifier status. Tap this button to
open the Inputs tab where you can set the input signal amplification or attenuation values. Use this button if you
connect an attenuator or amplifier to the input signal.
See the RF Scout Online topic The Inputs Tab for more information on setting the RF signal external attenuator
or amplifier parameters.
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The Measurement Mode Buttons
The Measurement Mode buttons select the type of measurement or operation to perform.

Element Description
Select the Spectrum Measurements button to take spectrum, spectrogram, signal strength, audio
demodulation, and noise floor signal measurements.

Select the Channel Measurements button to take code power, codogram, EMF, and channel
scanner/analyzer measurements.

Select the iMap Mapping Mode button to open the Map tool and link instrument measurements
to a location on a map. Use for graphically recording measurements to help analyze signal
characteristics, locate interference, and save measurement/location information.
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The Parameter Entry Controls
The Parameter Entry controls (keypad and knob) let you enter or change numeric values in selected fields. You can use either tool
to enter or change a value.

Element Description
The input control field shows the current value of the selected field or object, as well as the label
for the field.

Tap the keypad button to display a keypad in which to enter a value in the selected field. The
keypad content changes to show the available entry functions for the selected item.

The knob control lets you scroll through and select from all available values.

1. Drag the knob circle left or right to quickly scroll through all available values and select a value.

2. Tap the arrows on the top half of the knob icon to step the value in large increments. The
increment value depends on the value type (channel or frequency).

3. Tap the arrows on the bottom half of the knob icon to step the value in single unit increments.
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Common Operations
Common operations are tasks that you need to do for almost all measurement functions.

Select a Signal Standard to Measure

1. Tap the Signal Standard List arrow button
to open the signal standard list.

2. Tap a signal standard to select it.
This signal standard is used for all
measurements until you change it.

Select a Signal Link Direction
1. Tap the Down Link or Up Link to select

the measurement signal link direction.
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Entering a Channel or Frequency Number

1. Tap the Channel or Freq (MHz) button to
open the Enter keypad.

2. For channels, tap the Uplink or Downlink
option button to select the channel link
direction.

3. For channels, you can also tap the List
button to display a list of available channels
from which you can select a value.
Channel numbers are constrained to those
that are defined by the current signal
standard. If you enter a channel number
outside the valid range, the instrument sets
the channel number to the closest valid
number.

4. Tap OK to close the keypad or channel list
and set the channel value.
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5. For frequencies, use the keypad to enter
a frequency value. This sets the center
frequency of the measurement.
If there is a corresponding channel number
for the entered frequency, the instrument
displays that channel number in the
Channel field.

6. Tap a frequency unit button (GHz, MHz,
etc.) to close the keypad and set the
frequency value.

Setting Additional Measurement Parameters

1. Select a signal standard and measurement
type (for example, 1xEV-DO and Code
Power).
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2. Tap the Edit button to open the Setup
dialog box.

3. Tap the measurement parameters that you
want to set.

4. Tap OK to close the Setup dialog box
and enable the measurement parameter
settings.
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Setting Up to Take a Measurement
Perform the following steps to set up the instrument to take a measurement:

1. Select a signal standard from the Signal
Standard list.

2. Tap the appropriate signal Uplink or
Downlink button for the measurement that
you are taking.

3. Tap the Channel button and enter a
channel number in the Enter Channel
Number dialog box. This sets the
instrument to measure the frequency
associated with that channel and signal
standard.
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4. Select a measurement mode button.

5. For Spectrum and Channel measurements,
select the tab of the measurement that you
want to take.

NOTE. Most measurement procedures in this manual ask that you enter a channel number. You can enter a frequency to measure
by tapping the Freq (MHz): button, but generally for standard measurements it is easier to enter a channel number.
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Operating Basics
Spectrum Measurements Mode

Display a Spectrum Waveform

1. Select a signal standard, uplink or downlink
button, and channel or frequency to
measure.

2. Tap the Spectrum Measurement button.

3. Tap the tab of the measurement that you
want to take.
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4. Tap the AutoLevel button.

5. Set measurement parameters if available
with the measurement. For example, the
Spectrum measurement lets you set the
frequency span, resolution bandwidth
(RBW), signal attenuation value, graph
reference and division values, start and
stop frequencies, and marker positions.
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6. Tap the Edit button to open the Setup
dialog box and set additional measurement
parameters. Available parameters depend
on the current signal standard and
measurement type. Not all measurements
have setup parameters.
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Spectrum Waveform Markers
Markers are visual icons that you position on a spectrum waveform to measure signal frequency and level values. You use the
markers to measure the value at a particular point on a waveform (Absolute Marker Values), or measure the difference between two
markers (Delta Marker Values). The markers follow the waveform level changes.

Each marker icon has an associated marker readout, displayed at the bottom of the Spectrum display. The marker readout shows
the marker icon symbol, the marker name, and the frequency and level values for the marker.

There are a maximum of six markers available, labeled M1 through M6. Each marker icon has a different shape and color.
Only the first two markers are shown by default.

Turning Markers On and Off.

1. Tap View.

2. Tap Markers to turn marker display on or
off.
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Selecting Which Markers to Display.

1. Select View > Marker Setup... to display
the Markers dialog box.

2. Tap to enable or disable markers and set
the marker mode:
On enables or disables the selected
marker.
Front Trace places the marker on the front
trace.Front Trace places the marker on
the front trace.
Trace 1 and Trace 2 keep the marker on
the specified trace regardless of which
trace is in front. Use this mode to do
measurement comparisons between two
waveform traces.
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3. Tap OK. The instrument shows the center
frequency readout plus three marker
readouts at a time (in Absolute Marker
Readouts mode) or the center frequency
readout plus two marker readouts at a time
(in Delta Marker Readouts mode).

4. Tap the marker readout scroll buttons
to scroll through the enabled marker
readouts.
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Setting the Marker Measurement Mode.

1. Tap View.

2. Tap Delta Marker Readouts to enable
marker readouts to display the difference
(delta) between the frequency and level
values at marker M1 and the other markers.
While in Delta Marker Readouts mode, all
marker readouts are relative to marker M1.

3. Tap Absolute Marker Readouts to enable
marker readouts to display the actual
frequency and level values of the signal at
the marker position on the waveform.
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Add a Marker to a Waveform.

1. Tap View.

2. Tap Measurement Frequency Cursor.

3. Tap the marker readout of the marker that
you want to add to the spectrum waveform.
The marker readout border darkens to
indicate that it is selected.

4. Tap the waveform where you want to add
the marker. The marker is added to the
waveform and the readout shows the signal
values at the new location.

5. Use the Parameter Entry controls to
fine-tune the position of the marker on the
waveform.
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Moving a Marker on a Waveform.

1. Tap View.

2. Tap Measurement Frequency Cursor.

3. Tap the marker readout of the marker
that you want to move. The marker
readout border darkens to indicate that it
is selected.
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4. Tap the waveform where you want to move
the marker. The marker moves to the new
position and the readout shows the signal
values at the new location.

5. Use the Parameter Entry controls to
fine-tune the position of the marker on the
waveform.
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Comparing Spectrum Waveform Traces
You can compare two live waveforms (derived from the single RF input signal), the RF input signal waveform and a saved
waveform, or two saved waveforms.

Selecting a waveform (Trace).

1. Tap the Traces button to toggle
betweenTrace 1 and Trace 2.

Comparing Live Waveform Traces.

1. Set the instrument Spectrum parameters
to display the waveform. (See page 36,
Spectrum Measurements Mode.)

2. Tap the Traces button to select Trace 1.

46 RF Scout Quick Start User Manual



Operating Basics

3. Tap the Trace 1 list button and then tap
a trace type to select it. The instrument
applies the selected operation to the RF
input signal and displays the results as the
trace 1 waveform.

4. Tap the Traces button to select Trace 2.

5. Tap the Trace 2 list button and then tap a
trace type to select it.
The instrument applies the selected
operation to the RF input signal and
displays the results as the trace 2
waveform, along with the trace 1 waveform.
The figure shows Trace 1 as an Normal
waveform and Trace 2 as a Min Hold
waveform.
You can use markers to make
measurements between the waveforms.
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Comparing a Live Waveform to a Saved Waveform.

1. Tap the Traces button to select Trace 1.

2. Tap the Trace 1 list button and then tap a
trace type to select it.

3. Set the instrument Spectrum parameters
to display the waveform to compare. (See
page 36, Spectrum Measurements Mode.)

4. Tap the Traces button to select Trace 2.
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5. Tap the Trace 2 list button and tap Saved
to open the Trace 2 & Mask setup tab.

6. Tap Saved Trace.

7. Enter a file path and name of a saved
waveform file, or tap the Browse button to
navigate to and select the saved waveform
to open.

8. Tap OK. The instrument displays the saved
waveform as the Trace 2 waveform. You
can use markers to make measurements
between the waveforms.

NOTE. The current instrument measurement settings must match the instrument settings used to capture the saved waveform.
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Comparing Two Saved Waveform Traces.

NOTE. Waveform traces are saved with the settings in effect at the time the trace is saved. When a saved trace is displayed, the
stored settings values are shown for reference, though no actual instrument settings change. As soon as you tap the Run button to
return to making new acquisitions, the display settings are restored to what they were before the saved trace was opened.

1. Select File > Compare Saved.

2. Navigate to and select the first waveform
file to load.

3. Tap OK to open the Select second result
file to compare dialog box (looks exactly
the same as the first dialog box).

50 RF Scout Quick Start User Manual



Operating Basics

4. Navigate to and select the second
waveform file to load.

5. Tap OK to enter the second file and close
the dialog box. The instrument displays
both waveforms.

6. When you are done viewing the waveforms,
tap the Run button to return the instrument
to taking measurements.
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Change the Spectrum Waveform Graph Values

1. Tap the Ref Lvl field or the Vertical Scale
field to select it.

2. Use the Parameter Entry controls to enter
or change the scale setting.
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For More Spectrum Measurements Help
For more information on Spectrum measurements, access the RF Scout Online help:

1. Tap the Spectrum measurement mode
button.

2. Tap the measurement tab for which you
want help.

3. Tap the Help button. RF Scout opens an
Online help window with information on the
selected measurement, as well as links to
related topics or tasks.

RF Scout Quick Start User Manual 53



Operating Basics

Channel Measurements Mode
Channel measurements mode includes measurements for Code Power, Codograms, EMF, Channel scanners, and Scrambling
Code Analyzers.

Taking a Channel Measurement
The following procedure assumes that you have already set up the measurement. (See page 34, Setting Up to Take a
Measurement.)

1. Tap the Channel Measurement button.

2. Tap the tab of the measurement that you
want to take. The signal standard sets the
available measurements.
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3. Tap available measurement parameters
and use the Parameter Entry controls to
set measurement parameter values.

4. Tap the Edit button to open the Setup
dialog box and set additional measurement
parameters. Available parameters depend
on the current signal standard and
measurement type. Not all measurements
have setup parameters.
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For Channel Measurements Help
For information on specific Channel measurements, access the RF Scout Online help:

1. Tap the Channel Measurement button.

2. Tap the measurement tab for which you
want help.

3. Tap the Help button. RF Scout opens an
Online help window with information on the
selected measurement, as well as links to
related topics or tasks.
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iMap Measurement Mapping
iMap integrates interference mapping, coverage mapping, in-building mapping, outdoor mapping, and provides an integrated
solution for field interference and coverage problems in one instrument.

Using iMap is as easy as selecting a measurement and touching the displayed map where you want the measurement to be placed.
Measurement icons are color coded to indicate if they have passed or failed limit tests. You can also add a direction arrow to a
measurement to indicate the direction the antenna was pointing when you made a measurement.

You can load scanned bitmap files as maps for in-building mapping, or use GSF and MIF map file formats for outdoor maps.
Using GSF or MIF map files lets you use a connected GPS receiver (such as the Tektronix YBGPS1 GPS Timing Reference) to
automatically place measurements at your current location.

You can save maps and associated measurement results data to common file formats such as CSV or MapInfo. Saving maps
and measurement results lets you analyze measurement data (position, value, and direction) and prepare reports to help resolve
interference problems.

1. To start the iMap tool, tap the iMap button.
When you open the iMap tool for the first
time, the screen displays the message No
map loaded. Otherwise iMap displays the
last-loaded map.
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Map File Concepts
The iMap tool uses two types of maps; Grid and Image.

Grid Maps. Grid maps have geophysical latitude and longitude coordinate references embedded in the map file. Such maps
require specialized PC software to create or must be purchased from map-creating companies. The iMap tool can load GSF- and
MIF-format grid map files. You need to convert non-GSF or MIF grid maps to GSF format before you can load them into the iMap
tool. (See page 59, Converting Map File Formats to GSF.)

Grid maps require an active GPS receiver to correctly link measurements to geophysical map locations. An active GPS receiver is a
receiver that is locked to four or more satellite signals and is providing the RF Scout with accurate GPS location data. If you load a
grid map and a GPS receiver is either not connected or does not have a good satellite signal lock, the instrument considers the
grid map as an image map.

Image Maps. Image maps do not have any geophysical latitude and longitude references embedded in the map file. Simply
put, an image map is a bitmap picture, such as a scanned building floor plan or aerial photograph, to which you can attach
measurements. Save the file to 256-color bitmap format.

NOTE. Image (bitmap) files that you convert to GSF-format load faster on the RF Scout because the instrument does not have to
do the bitmap-to-GSF conversion in the instrument. However, it is then possible to confuse image GSF maps with grid (coordinate)
GSF files. Use a file naming convention to differentiate between GSF maps that were created from coordinate maps and GSF maps
that were created from bitmap files.
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Converting Map File Formats to GSF
RF Scout includes a map file conversion program. The iMap Converter program converts industry-standard MapInfo Interchange
Format (.mif), ArcInfo Shape (.shp), USGS Digital Line Graph (.opt) geographic coordinate maps, as well as 256-color bitmap
images (.bmp), into GSF-format files for use with RF Scout. The program also lets you combine multiple coordinate map files into a
single map. iMap Converter is installed at the same time as the RF Scout PC Simulator install.

NOTE. Bitmap files that you convert to GSF-format load faster on the RF Scout because the instrument does not have to do
the bitmap-to-GSF conversion in the instrument. However, it is then possible to confuse image GSF maps with grid (coordinate)
GSF files. Use a file naming convention to differentiate between GSF maps created from coordinate maps and GSF maps
created from bitmap files.

1. On the PC, select Start > Programs >
NetTek > iMap Converter.
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2. Click the Open Road Map(s) button to
open grid (coordinate) map files, or click
on the Open Floor Map button to open a
Bitmap (image format) file.

3. Use the dialog box to navigate to and
select one or more grid map files or a
single bitmap file.

4. Click Open. The iMap converter loads
the file, converts the data, and draws the
resulting map.
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5. Click the Save for NetTek button.

6. Use the dialog box to enter a map name
and navigate to the location to save the
GSF-format map file.

7. Click Save to save the file.

NOTE. The iMap Converter program saves all files as GSF-format. This includes bitmap files that you convert to GSF-format to
reduce the map file size and loading time. Therefore it is possible to have GSF-format maps that are not grid (coordinate) maps. Use
a file naming convention to differentiate between GSF maps created from coordinate maps and GSF maps created from bitmap files.

The MIF-format files take significantly longer to load than the GSF-format files. Tektronix recommends that you use iMap Converter
to convert MIF map files to GSF map files, rather than loading MIF files directly on the instrument.
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Loading a Map
You need to load a map before you can use the iMap tool.

1. With iMap open, select File > Load Map....

2. Navigate to and select the map file to load
(Bitmap, GSF or MIF format).

3. Tap Open. iMap loads the map on the
screen.
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Mapping a Measurement
The following procedure assumes that you have already set up the measurement (See page 34, Setting Up to Take a
Measurement.) and loaded a map file (See page 62, Loading a Map.).

1. Tap the Single Measurement button.

2. Tap a measurement button. Available
measurements depend on the current
signal standard. The selected
measurement is displayed in the
Measurement Thumbnail area.
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3. Tap the map:

If a connected GPS receiver is active, and
you are using a grid map, then a single
measurement is placed at the current GPS
latitude and longitude coordinates.

If a GPS receiver is not active, or if you are
using an image map (such as a building
floor plan), then a single measurement is
placed where you tapped the map.

4. You can select a different measurement
button and then tap the map to add a
new measurement to the map. Multiple
measurement icons at the same location
stack on top of each other.
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NOTE. To add measurements at a new location on a grid map with an active GPS receiver, you must physically move to the
new location.

iMap Measurement Icon Colors
The measurement icon border color indicates the measurement limit or mask testing status:

A blue icon border means that limit or mask testing is not enabled for the measurement.

A green icon border means that limit or mask testing is enabled for the measurement, and that the measurement is within
the set limits (pass).

A red icon border means that limit or mask testing is enabled for the measurement and that the measurement is outside the
defined limits (fail).

For signal strength and noise floor measurements, the border color indicates the relative signal strength, from low signal levels
(black) to high signal levels (red).
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Viewing Measurement Icon Results
To view the measurement results associated with a measurement icon on a map:

1. Tap the iMap Select mode button.

2. Tap the measurement icon on the map to
open the Map Measurements dialog box.
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3. Tap the measurement in the list to view.

4. Tap Open. iMap opens the measurement
screen for the selected measurement.

5. Tap the iMap button to return to the iMap
screen.

NOTE. You can also double-tap on a measurement icon to directly open the appropriate measurement window for that
measurement. If there are multiple measurements at the selected location, iMap displays the results for the measurement icon that
is at the top of the list (usually the most recent measurement).
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Deleting Mapped Measurement Icons

1. Tap the measurement icon on the map.

2. Tap the measurement name that you want
to delete.

3. Tap the Delete button. iMap deletes the
selected measurement results and icon
from the map.
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Draw a Measurement Icon Direction Arrow
The iMap direction arrow function lets you draw an arrow on a mapped measurement icon. You can use the arrow to indicate the
direction your antenna was pointing when you took a measurement.

1. Tap the Measurement Direction button.

2. Tap and drag from the center of a
measurement icon in the direction
the antenna was pointing when the
measurement was made. iMap draws an
arrow from the measurement icon.

3. To change the arrow direction, draw a new
line. iMap replaces the existing arrow with
the new direction arrow.
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Delete a Direction Arrow. To delete a direction arrow from a measurement icon:

1. Tap the iMap Select mode button.

2. Single-tap the measurement icon with the
direction arrow to delete. iMap opens the
Map Measurements dialog box.

3. Tap the measurement name that has the
direction arrow to delete.

4. Tap the Remove Arrow button.

5. Tap OK. iMap closes the dialog box and
deletes the direction arrow.
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Moving a Measurement Icon

1. Tap the Select button.

2. Drag a measurement icon:

If a GPS receiver is not active, or if
you are using an image map (such as a
building floor plan), then iMap moves the
measurement icon to the position to which
you drag it.

If a connected GPS receiver is active
and you have loaded a grid map in the
instrument, then iMap repositions the
entire map and all measurement icons in
the direction that you drag it. No icons are
moved relative to the map.

NOTE. When moving measurement icons, be aware that when the GPS receiver is not active, you can move any type of
measurement icon. This includes moving measurement icons that were placed on the map while in GPS mode. The iMap
tool does not reposition moved GPS-related measurement icons back to their original geophysical position on a map when
the GPS receiver is active.
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Logging iMap Measurements (Automatic Measurements)
Logging measurements lets you automatically map a single measurement at a set time interval or change in GPS position (with
active GPS receiver and a grid map).

1. Tap a measurement button. Available
measurements depend on the current
signal standard.

2. Tap the Log Measurements button.
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3. Select the type of repeat measurement
to take (time interval or distance between
measurement positions).

4. Tap OK to return to the mapping screen.

5. Tap the map to start logging measurements:

For grid maps with an active GPS receiver,
tap the map at any point. The instrument
begins adding measurement flags to the
map at the current GPS position.

For image maps or for grid maps without
an active GPS receiver, tap the map at
the measurement starting location. The
instrument begins taking measurements,
but does not display them on the map until
measurement logging is done.
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6. Tap the map to stop measurements:

For grid maps with an active GPS receiver,
tap the map at any position.

For image maps or grid maps without an
active GPS receiver, tap the map at the
position the last measurement was taken.
Measurements are then evenly spaced
between the start and stop map points.

7. To exit the logging measurements mode,
tap the Single Measurement or the Select
button.
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NOTE. The iMap Log measurements function automatically sets the map view measurements mode (View > Display
Measurements) to disable viewing measurement icons on the map during logging measurement acquisition. While in Log mode,
iMap places flag icons on the map to indicate measurement positions. When iMap measurement logging is done, the instrument
restores the map view measurements mode to whatever state it was at prior to starting the iMap measurement logging.

If you tap the Select, Measurement Direction, or Single Measurement button while logging measurements in non-GPS mode,
iMap cancels the log measurements mode and does not draw any measurement icons on the map.

Grid maps with an active GPS receiver support logging measurements by time interval or distance change interval. Image maps, or
grid maps with an inactive GPS receiver, support logging measurements by time intervals.

For More iMap Help
For more information on using the iMap tool, access the RF Scout Online help.

1. Tap the iMap button.

2. Tap the Help button. RF Scout opens an
Online help window with an overview of
the iMap tool, as well as links to common
iMap tasks.
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Specifications
This section lists the electrical, environmental, and physical specifications of the RF Scout Interference Hunter. All specifications
are guaranteed unless labeled “typical”. Typical specifications are provided for your convenience and are not guaranteed.

Table 1: General characteristics

Characteristic Description
RF Input

Input Frequency Range 30 MHz – 2500 MHz
Input Impedance 50 ohms (nominal)
Signal Amplitude for
Modulation Measurements

-50 dBm to +30 dBm for CW-like or peak envelope power
Measurements may be outside this range but accuracy is not guaranteed

Signal Amplitude for
Spectral Display, typical

CW or peak envelope power:
-144 dBm to +30 dBm, 200 MHz to 2.0 GHz
-142 dBm to +30 dBm, 2.0 GHz to 2.2 GHz
-139 dBm to +30 dBm, 2.2 GHz to 2.5 GHz
Levels apply when using 100 Hz resolution bandwidth

Input Overload Detect >1 W (+30 dBm) CW or peak envelope power
Maximum Input Power
without Damaging
Instrument

50 W CW or peak envelope power

Coupling AC for all measurements and spectral display modes
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Table 1: General characteristics (cont.)

Characteristic Description
Maximum Working Voltage 15 V (DC + peak AC)
Spurious Input Signals To meet modulation measurement specifications:

(Total power of interest - Total power in spurious) > 35 dB
or
| Center frequency of signal of interest - center frequency of spurious signal | > 1.4 MHz
and
(Total power of interest - Total power in all spurious) ≥ -3 dB

Frequency Reference Input
Impedance 50 ohms (nominal)
Frequency Range Any multiple of 1 MHz up to 15 MHz inclusive, ± 1 ppm

Any multiple of 1.2288 MHz up to 19.6608 MHz inclusive, ± 1 ppm
2.048 MHz ± 1 ppm
4.8 MHz ± 1 ppm

Level Range -15 dBm to +15 dBm
Maximum Input Level
without Damage

± 3 V peak continuous

Coupling AC
Working Voltage 3 V (DC + pk. AC)
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Table 1: General characteristics (cont.)

Characteristic Description
Lock Time < 15 seconds

Timing Input
Impedance 10 kΩ
Minimum High Threshold 2.0 V
Maximum Low Threshold 0.8 V
Minimum High Time 10 ns
Minimum Low Time 10 ns
Maximum Input Level
without Damage

± 5 V peak continuous

Coupling DC
Timing Error ± 10 ppm

Internal Time Base
Characteristics
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Table 1: General characteristics (cont.)

Characteristic Description
Error ± 0.5 ppm drift from 0 °C to 50 °C

± 1.0 ppm aging/year
Ten minute warm-up period required to meet accuracy specification.
Users can connect the External Reference input to a frequency source and obtain a user
correction value. This value will be used to correct time base errors in measurements to
the accuracy of the external reference. The internal time base will continue to drift with
temperature and age as specified above.

Signal Path Characteristics
Phase Noise ≤ -75 dBc/Hz @ 20 kHz carrier offset
Noise Figure 1 kHz resolution bandwidth:

≤10 dB, 200 MHz to 2000 MHz
≤12 dB typical, 2000 MHz to 2200 MHz
≤15 dB typical, 2200 MHz to 2500 MHz

Displayed Average Noise
Level (DANL), typical

10 Hz RBW: -152 dBm, 200 MHz to 2000 MHz
100 Hz RBW: -145 dBm, 200 MHz to 2000 MHz
1 kHz RBW: -135 dBm, 200 MHz to 2000 MHz
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Table 2: Measurement characteristics

Measurement Description
External
Attenuation

User Selectable ON/OFF
Attenuation = -30 dB to +80 dB

Code Domain
Power (cdmaOne,
cdma2000,
W-CDMA)

Measures the power in each of the Walsh codes (64 in cdmaOne, 128 in cdma2000) used in a CDMA
signal.
Measures the power in each of (up to 512) OVSF codes used in a W-CDMA signal.

Units dB relative to Pilot Power or Total Power
Resolution 0.1 dB
Accuracy cdmaOne and cdma2000: ± 1 dB code domain power level > -20 dB relative to total power, using the

recommended TIA/EIA-IS-97-D pilot level of -7.0 dB (20%) relative to total power.
W-CDMA: ± 1 dB Code domain power level > -20 dB relative to total power, using W-CDMA 3GPP
Test Model 3.
Reference Information:
± 2.5 dB for -27 dB < CDP < -20 dB relative to total power in band classes 0-6 (cdmaOne, cdma2000).
± 2.5 dB for -27 dB < CDP < -20 dB relative to total power (W-CDMA).
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Table 3: Spectral analysis

Characteristic Description
Measurement
Frequency

Sets the measurement frequency of the display. The measurement frequency can be set by either
entering a specific frequency or by selecting a channel number.

Units MegaHertz (MHz) or Channel Number
Resolution 1 kHz 1 channel
Range 30 MHz to 2500 MHz

Frequency Span Sets the frequency range covered by the spectral display.
Units kiloHertz (kHz) MegaHertz (MHz)
Resolution 1 kHz
Range 10 kHz to 2470 MHz, continuously variable or 1-2-5 steps

Resolution Bandwidth
(RBW)

Width of the resolution bandwidth filter

Units Hertz (Hz), kiloHertz (kHz), MegaHertz (MHz)
Resolution Uses 1-3 steps to cover the range
Range 10 Hz to 6 MHz

When in Auto mode, the instrument automatically sets the RBW. The RBW is set as a combination
of 1-3 steps at the 1, 2, 5 span settings, and a linear range between 1, 2, 5 span settings, for
a nominal value of approximately Span/125.

Reference Level The power level indicated by the top line of the spectral display
Units dBm
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Table 3: Spectral analysis (cont.)

Characteristic Description
Resolution 1 dBm
Range -100 dBm to +30 dBm

Spectral Display
Amplitude

Units dB relative to Reference Level
Resolution 0.1 dB
Accuracy ± 1.25 dB, -20 dBm to +30 dBm

± 2.0 dB, -80 dBm to -20 dBm
± 2.75 dB, -120 dBm to -80 dBm
± 5 dB -134 dBm < Input < -120 dBm, typical
Accuracy specifications apply only for spans less than 1000 MHz and to CW-like signals.

Vertical Scale Factor
Units 1 dB to 10 dB in 1 dB increments
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Table 3: Spectral analysis (cont.)

Characteristic Description
Display Modes Normal: updates display with each new result

Max Hold: updates displayed point only if new point > old point
Min Hold: updates displayed point only if new point < old point
Max/Min Hold: displays a bar between Max Hold and Min Hold
Average: displays average of N (specified by user) results
Reference Information:
Average is calculated as follows: The last N values are saved in memory; when a new result is
available, the earliest result of the N stored values is discarded, the new average is calculated from
the stored values. If the number of results is less than N, then all of the results are averaged together.

Number of Averages 1 ≤ N ≤ 99
Spurious Free
Dynamic Range
(external signal
related)

IM3 better than -70 dBc typical, 100 MHz to 2500 MHz
2nd Harmonic better than -60 dBc, typical

Residual Spurious
Signals

-125 dBm at BTS Rx frequencies (776–794, 806–849, 872–940, 1453–1465, 1525–1549,
1710–1785, 1840–1910,1920–1980) MHz and GPS frequencies (L1 1570.3–1580.5, L2
1222.5–1232.8, L5 1171.4–1181.6) MHz
-115 dBm at BTS Tx frequencies (746–764, 832–834, 840–960, 1477–1513, 1805–1880,
1930–1990, 2110–2170) MHz
-95 dBm at frequencies not listed above, except from 1155–1168 MHz: -20 dBm in spans above 10
MHz, 1155 MHz –1175 MHz
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Table 4: Interference analysis characteristics

Characteristic Description
Noise Floor
Measurement

Measures the interference power that is coming into the receiver antenna for any standard.
Measurement defaults to uplink channel when specified by channel number.

Units dBm
Resolution 0.1 dB
Accuracy ± 3 dB typical

AM Demodulation Provides an audio output signal after AM demodulation of the user-selected signal to use for
identifying a signal

Measurement
Frequency

30 MHz to 2500 MHz with 1 kHz resolution

Input Signal Level -100 dBm minimum
Measurement
Bandwidth

8 kHz

Audio Output
Bandwidth

4 kHz

Run Time 4 seconds per activation
FM Demodulation Provides an audio output signal after FM demodulation of the user-selected signal to use for

identifying a signal
Measurement
Frequency

30 MHz to 2500 MHz with 1 kHz resolution
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Table 4: Interference analysis characteristics (cont.)

Characteristic Description
Input Signal Level -100 dBm minimum
Maximum Signal
Deviation

Up to 100 kHz

Measurement
Bandwidth

8 kHz, 15 kHz, 75 kHz, 200 kHz; selected by user

Audio Output
Bandwidth

4 kHz for Measurement BW = 8 kHz, 15 kHz
15 kHz for Measurement BW = 75 kHz, 200 kHz

Run Time 4 seconds per activation
Signal Strength Indicator Provides an audio tone and a visual display that vary with the strength of the selected signal

Measurement
Frequency

30 MHz to 2500 MHz with 1 kHz resolution

Input Signal Level -110 dBm minimum
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Table 4: Interference analysis characteristics (cont.)

Characteristic Description
Measurement
Bandwidth

Up to 10 MHz, dependent on span setting

Tone Type Variable beep rate, based on signal strength
Variable frequency tone, based on signal strength

Table 5: Scanner characteristics

Characteristic Description
W-CDMA Scrambling
Code Analyzer

Detects scrambling codes and pilot channel power levels of received co-channel W-CDMA
downlink signals.

Input Signal Range -117 to +30 dBm, typical
Units Io, Ec: dBm

Ec/Io: dB
Resolution 0.1 dB
Accuracy Ec:

±2 dB for Ec ≥ -102 dBm and Ec/Io ≥ -12 dB, typical
±3 dB for Ec ≥ -112 dBm and Ec/Io ≥ -14 dB, typical

Display Controls Sort by Power (descending Ec value)
Sort by Scrambling Code (ascending SC index)
Lock (set) current Scrambling Code set
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Table 5: Scanner characteristics (cont.)

Characteristic Description
cdma2000 PN Scanner Detects PN Offset, Tau (Timing Error) and Pilot Channel power levels of multiple co-channel

cdmaOne and/or cdma2000 forward link signals.
Input Signal Range -120 to +30 dBm, typical
Units Io, Ec: dBm

Ec/Io: dB
PN Offset: PN index (0 to 511)
Tau: chips

Resolution Ec, Io, Ec/Io: 0.1 dB
PN Offset: 1 PN
Tau: 0.1 chip

Accuracy Ec:
±2 dB for Ec ≥ -95 dBm and Ec/Io ≥ -8 dB, typical
±3 dB for Ec ≥ -110 dBm and Ec/Io ≥ -12 dB, typical
Tau:
0.5 chip, of highest power multipath component of each detected PNOS, relative to input timing
reference (ESC or YBGPS1), typical.

Display Controls Sort by Power (descending Ec value)
Sort by PN offset (ascending offset values)
Lock (set) current PN Offset values
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Table 5: Scanner characteristics (cont.)

Characteristic Description
1xEV-DO PN Scanner Detects PN Offset, Tau (Timing Error) and Pilot Channel power levels of multiple co-channel

1xEV-DO forward link signals. Up to 10 PN offsets are displayed.
Io: The total received power in the pilot intervals of the signal, within the signal bandwidth (1.23
MHz).
Ec: The absolute power level of the detected pilot at the indicated PN Offset, in dBm.

Input Signal Range -120 to +30 dBm, typical
Units Io, Ec: dBm

Ec/Io: dB
PN Offset: PN index (0 to 511)
Tau: chips

Resolution Ec, Io, Ec/Io: 0.1 dB
PN Offset: 1 PN
Tau: 0.1 chip

Accuracy, typical Ec:
± 2.5 dB for Ec ≥ -95 dBm and Ec/Io ≥ -8 dB
± 3.5 dB for Ec ≥ -110 dBm and Ec/Io ≥ -12 dB
Tau:
±0.5 chip, of highest power multipath component of each detected PNOS, relative to input timing
reference (ESC or YBGPS1)
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Table 5: Scanner characteristics (cont.)

Characteristic Description
Display Controls Sort by Power (descending Ec value)

Sort by PN offset (ascending offset values)
Lock (set) current PN Offset values

GSM Channel Scanner The GSM channel scanner displays channel power and related information on a maximum of 128
GSM forward link signals.
Displays Channel, Frequency, Peak Power, Traffic Type, C/I, and BSIC
The scanner is intended for off-air reception using an antenna, and measures only forward (down)
link signals. This measurement requires that YBT250 option GS1 is installed.

Input Signal Range -120 to +30 dBm, typical
Units Frequency: MHz

Peak Power: dBm
C/I: dB

Resolution Frequency: 0.001 MHz
Peak Power: 0.1 dBm
C/I: 0.1 dB
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Table 5: Scanner characteristics (cont.)

Characteristic Description
Accuracy, typical ± 1 dB, -20 dBm to +30 dBm, ± 0.75 dB for identified GSM channels

The center frequency is derived from the channel number
C/I is derived from EVM using the following equation:

C/I = -20 * log10(EVM/100)
Display Controls AutoLevel (graph)

Sort table by power or frequency
Start and stop channel select
Peak hold

Table 6: Environmental characteristics

Characteristic Description
Temperature Range Operating: 0 °C to +50 °C specified performance, -10 °C to +50 °C typical

Nonoperating: -40 °C to +60 °C
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Table 6: Environmental characteristics (cont.)

Characteristic Description
Humidity Operating: 5% to 95% Relative Humidity (RH), noncondensing: up to +30 °C

Nonoperating: 5% to 45% Relative Humidity (RH), noncondensing: +30 °C up to +50 °C
Altitude Operating: Up to 4,600 m (15,092 ft.)

Nonoperating: Up to 15,240 m (50,000 ft.)

RF Scout Quick Start User Manual 91



Specifications

Table 7: Physical characteristics

Characteristic Description
Dimensions Height: 25 cm. (9.75 in)

Width: 33 cm. (13 in)
Depth: 9 cm. (3.5 in)

Weight (Y400, YBT250,
and 1 battery)

5.5 kg (12.125 lbs)
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Table 8: Miscellaneous characteristics

Characteristic Description
Battery Life One battery installed: 2 hours with measurements active, 4 hours in suspend mode

Two batteries installed: 4 hours with measurements active, 8 hours in suspend mode
Recommended Instrument
Calibration Interval

2 years

Table 9: Safety compliance

Category Description
Safety Compliance ANSI/UL61010-1:2004

Electrical Equipment for Measurement, Control, and Laboratory Use.
CSA C22.2 No. 61010.1:2004

Electrical Equipment for Measurement, Control, and Laboratory Use.
EN 61010-1:2001

Electrical Equipment for Measurement, Control, and Laboratory Use.
IEC61010-1:2001

Electrical Equipment for Measurement, Control, and Laboratory Use.
ISA 82.02.01

Electrical Equipment for Measurement, Control, and Laboratory Use.
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Table 10: Electromagnetic compatibility (EMC)

Category Standards or description
EC Declaration of
Conformity — EMC

Meets the intent of Directive 89/336/EEC for Electromagnetic Compatibility. Compliance was
demonstrated to the following specifications as listed in the Official Journal of the European Union:
EN 61326 Annex D, EMC requirements for Class A electrical equipment for measurement, control,
and laboratory use 1 2 3

IEC 61000-4-2 Electrostatic discharge immunity
IEC 61000-4-3 4 Radiated RF electromagnetic field immunity
IEC 61000-4-4 Electrical fast transient/burst immunity
IEC 61000-4-5 Power line surge immunity
IEC 61000-4-6 4 Conducted RF immunity
IEC 61000-4-11 Voltage dips and interruptions immunity
EN 61000-3-2 Conducted power line harmonic current
EN 61000-3-3 Voltage changes, fluctuations, and flicker

Australia/New Zealand
Declaration of Conformity
— EMC

Complies with EMC provision of Radiocommunications Act per the following standard(s): 1 2

AS/NZS 2064.1/2 Industrial, Scientific, and Medical Equipment: 1992

1 EMC compliance was demonstrated using high-quality shielded interface cables.
2 Emissions that exceed the limits of this standard may occur when the instrument is connected to a test object.
3 Minimum immunity test requirement.
4 Residual spurious signals can increase to -70 dBm with exposure to the disturbance levels of this test.
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Index
A
AC Adapter, 2
AC adapter, connecting, 4
Accessories, standard, 1
Active GPS receiver and maps, 58
Active GPS, definition, 58
Adapter, AC, connecting, 4
Add a marker to a waveform, 43
Add signal standards to select list, 14
Altitude, 2
Amplifier, RF input signal, 27
ArcInfo Shape (.shp) map file, 59
Attenuator, RF input signal, 27
Automatic iMap measurements, 72

B
Batteries

charge times, 5
charging, 5

Battery status, 18
Bitmap file (iMap), 58
BMP, 58

Border color, iMap measurement
icons, 65

Button
Channel measurement mode, 28
channel select, 25
downlink, 25, 34
Edit, 24, 32
F EXT, 26
F GPS, 26
F INT, 26
forward link, 25
frequency select, 25
GPS status, 26
Help, 24
iMap log measurements, 72
iMap mapping mode, 28
log measurements (not iMap), 24
log measurements, iMap, 72
measurement mode, 28
measurement reference

frequency status, 26
Open, 24
Pause, 24
power on/standby, 18

reset, 18
reverse link, 25
RF input signal gain/loss, 27
Run, 24
save results, 24
Spectrum measurement

mode, 28
traces, 46
uplink, 25, 34

C
Calibrate the touch screen, 9
Change the spectrum graph reference

level, 52
Change the spectrum graph vertical

scale, 52
Changing application colors for

printing, 13
Changing numbers in fields, 29
Channel measurement mode

button, 28
Channel select button, 25
Charging the batteries, 5
Cleaning the instrument, 3
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Clock, Even Second, 20
Color, iMap measurement icons, 65
Command bar, 22, 24
Common Operations, 30
Comparing live and saved

waveforms, 48
Comparing two live waveforms, 46
Comparing two saved waveforms

(spectrum), 50
Concepts, touch screen, 8
Connecting the AC adapter, 4
Connectors

input & output (Y400), 19
Reference Frequency Input, 20
RF Input, 20
Timing Input, 20
YBT250 module, 20

Conventions used in this manual, ix
Converting maps to GSF, 59

D
Definition

active GPS receiver, 58
grid map, 58
image map, 58

Deletemap measurement icons,
iMap, 68

Dimensions, 2
Direction arrow, iMap, 69
Display a spectrum waveform, 36
Display on/off status, 18
Displaying markers, 39
Documentation, viii
Downlink button, 25, 34
Drag, 8
Drawing a map measurement direction

arrow, 69

E
Edit button, 24, 32
Enabling signal standards, 14
Entering a channel or frequency, 31
Entering numbers in fields, 29
ESC, 20
Ethernet connector (RJ-45), 19
Even Second Clock, 20
External Reference status button, 22
External RF input signal amplifier, 27
External RF input signal attenuator, 27
External timing reference signal

input, 20

F
Forward link button, 25
Frequency reference input,

YBT250, 77
Frequency select button, 25
Front Trace (marker), 40
Functional verification, 7

G
GPS status button, 22, 26
GPS, active, definition, 58
Grid map, 58
.gsf, 58
GSF, 58
GSF, converting maps to, 59

H
Headphone jack, 19
Help button, 24
Humidity, 2

I
Image map, 58
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iMap
automatic map measure-

ments, 72
delete measurement icons, 68
direction arrow, drawing, 69
draw a direction arrow, 69
icon border color, 65
loading a map file, 62
log measurements button, 72
logging measurements, 72
map file concepts, 58
mapping a measurement, 63
measurement icon border

color, 65
measurement icons, delete, 68
measurement icons, viewing, 66
measurement mapping, 63
move a measurement icon, 71
tool overview, 57
viewing mapped measurement

icons, 66
iMap Converter, 59
iMap mapping mode button, 28
Improve measurement accuracy, 20
Indoor color scheme, 13
Input field entry controls, 29
Input/Output connectors, 19

Installation, 1

K
Key features, vii
Keypad button, 29
Knob control, 29

L
Lightning, preventing personal

injury, x
Live and saved waveforms,

comparing, 48
Loading a map file, 62
Log measurements button (not

iMap), 24
Log measurements button, iMap, 72
Logging iMap measurements, 72

M
Map file concepts, 58
Map file conversion program, 59
MapInfo Interchange Format (.mif)

map file, 59
Mapping a measurement, 63

Markers
absolute marker readouts, 42
add a marker to a waveform, 43
delta marker readouts, 42
displaying, 39
Front Trace, 40
marker readout scroll buttons, 41
measurement mode, 42
moving a marker on a

waveform, 44
overview, 39
selecting which markers to

display, 40
setup, 40
Trace 1, 40
Trace 2, 40
turning on or off, 39
View > Marker Setup, 40

Measurement icon border colors,
iMap, 65

Measurement icon direction arrow,
iMap, 69

Measurement icons, iMap,
deleting, 68

Measurement icons, iMap, viewing, 66
Measurement mapping, iMap, 63
Measurement mode buttons, 22, 28
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Measurement reference frequency
status button, 26

Measurement results screen, 22
Menus, 24
Microphone input, 19
Microsoft WindowsCE user

interface, 21
.mif, 58
MIF, 58
Move a measurement icon, iMap, 71
Moving a marker on a waveform, 44

O
Open button, 24
Opening RF Scout, 11
Operating considerations, 2
Outdoor color scheme, 13
Overview, iMap, 57

P
Parameter entry controls, 22, 29
Pause button, 24
Power On/Standby button, 18
Power/Display status, 18
Powering on and off the instrument, 6

Preventing personal injury from
lightning, x

PS/2 keyboard connector, 19

R
Readout scroll buttons, marker, 41
Ref Lvl, 52
Reset button, 18
Reverse link button, 25
RF input characteristics, 2
RF input signal connector, 20
RF input signal gain/loss button, 27
RF input, YBT250, 76
RF Scout application colors, 13
RF Scout elements, 17
RF Scout user interface, 22
RF Signal Gain/Loss status button, 22
Run button, 24
Running RF Scout, 11

S
Safety Summary, iii
Save results button, 24
Saved waveforms, comparing

(spectrum), 50
Screen display colors, 13

Select a signal link direction, 30
Select a signal standard to

measure, 30
Select signal standard to measure, 25
Select which markers to display, 40
Selecting waveforms (traces), 46
Serial RS-232 connector, 19
Set additional measurement

parameters, 32
Set signal standards, 14
Set which markers to display, 40
Setting display colors, 13
Setting the channel number, 25
Setting the measurement

frequency, 25
Setting up a measurement, 34
Setup dialog box, 32, 36
Signal standard selection list, 25
Software upgrades, viii
Specifications, 76
Spectrum

absolute marker readouts, 42
add a marker to a waveform, 43
change graph reference level, 52
change graph vertical scale, 52
comparing live and saved

waveforms, 48
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comparing two live
waveforms, 46

comparing two saved
waveforms, 50

delta marker readouts, 42
displaying markers, 39
Front Trace marker mode, 40
marker readout scroll buttons, 41
markers overview, 39
measurement mode, 42
moving a marker on a

waveform, 44
saved waveforms, comparing, 50
selecting waveforms (traces), 46
selecting which markers to

display, 40
setup markers, 40
take a measurement, 36
Trace 1 marker mode, 40
Trace 2 marker mode, 40
traces button, 46
turning on or off markers, 39
View > Marker Setup, 40
waveforms (traces), selecting, 46

Spectrum measurement mode
button, 28

Standard accessories, 1

Starting RF Scout, 11
Status panel, 18
Stylus, 8

T
Taking a spectrum measurement, 36
Tap, 8
Temperature Range, 2
Timing input, YBT250, 78
Touch screen

calibrate, 9
concepts, 8

Touch screen on/off status, 18
Trace 1 (marker), 40
Trace 2 (marker), 40
Traces button, 46
Tuning controls, 22, 25
Turning on or off markers, 39

U
Unpack the instrument, 1
Upgrades, software, viii
Uplink button, 25, 34
USB Host connector, 19
USB Slave connector, 19

User interface
command bar, 22, 24
External Reference status

button, 22
GPS status button, 22
Measurement mode buttons, 22
measurement results screen, 22
menus, 24
Parameter entry controls, 22
RF Signal Gain/Loss status

button, 22
tuning controls, 22

USGS Digital Line Graph (.opt) map
file, 59

V
Verifying instrument functionality, 7
Vertical Scale, 52
Viewing measurement icons, iMap, 66

W
Washing the instrument, 3
Waveform, moving a measurement

marker, 44
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Waveforms
add a measurement marker, 43
change graph reference level, 52
change graph vertical scale, 52
comparing, 46
comparing live and saved

waveforms, 48
comparing two live

waveforms, 46
comparing two saved

waveforms, 50
move a measurement marker, 44

Waveforms (traces), selecting, 46
Weight, 2

Y
Y400 user interface elements, 21
YBT250

Reference Frequency Input, 20
RF Input, 20
Timing Input, 20

YBT250 module
FREQUENCY REFERENCE

input, 77
RF input, 76
RF INPUT characteristics, 2
TIMING input, 78

YBT250 module connectors, 20

100 RF Scout Quick Start User Manual


	Title Page
	Warranty 2
	Table of Contents
	General Safety Summary
	Environmental Considerations
	Preface
	Key Features
	Documentation
	Software Upgrades
	Conventions Used in This Manual
	Preventing Personal Injury from Lightning

	Installation
	Standard Accessories
	Operating Considerations
	Connecting the AC Adapter
	Charging the Batteries
	Powering On and Off the Instrument
	Functional Verification
	Touch Screen Concepts
	Calibrate the Touch Screen
	Starting the RF Scout Application
	Setting Display Colors
	Enabling Signal Standards

	Getting Acquainted with Your Instrument
	RF Scout Elements
	Power On/Standby and Status Panel
	Input/Output Connectors (NetTek Y400)
	NetTek YBT250 Module Signal Connectors
	Microsoft WindowsCE Elements
	The RF Scout User Interface
	The Command Bar
	The Tuning Controls
	The External Signal Status Buttons
	The Measurement Mode Buttons
	The Parameter Entry Controls
	Common Operations
	Setting Up to Take a Measurement

	Operating Basics
	Spectrum Measurements Mode
	Channel Measurements Mode
	iMap Measurement Mapping

	Specifications
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.3
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Average
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /SyntheticBoldness 1.000000
  /Description <<
    /FRA <>
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /ENU <>
  >>
>> setdistillerparams
<<
  /HWResolution [1200 1200]
  /PageSize [612.000 792.000]
>> setpagedevice




